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  Working with WordArt
You're working with WordArt now.    The Enter Your Text Here dialog box is where you'll type the text you 
want for WordArt.

You can add special effects to the text by clicking the buttons on the WordArt toolbar.    If the application 
you're working in can't display the WordArt toolbar, you'll see these special effects buttons in the Word Art
dialog box instead.

When you've finished working with WordArt, click where you want to work next.    For more information on 
WordArt, such as a description of WordArt special effects, see the topics referenced below.
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WordArt Text Options
A Description of WordArt Special Text Effects



 Working with the WordArt Toolbar
You're working with WordArt now.    The WordArt top toolbar is where you add special effects to the text 
you've typed in the Enter Your Text Here dialog box.    

When you've finished working with WordArt, click where you want to work next.    For more information on 
WordArt, such as a description of the buttons on the toolbar, see the topics referenced below.
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A Description of WordArt Special Text Effects



 Typing and Editing Text in WordArt
The Enter Your Text Here dialog box is where you type the text you want for WordArt.

If the application you're working in can't display the WordArt toolbar, you'll enter your text in the WordArt 
dialog box instead.

To type or edit text in WordArt
1 In the Enter Your Text Here box, type the text you want for WordArt.

Press ENTER each time you want to start a new line.
2 On the WordArt toolbar, choose the special text effects you want.

If the application you're working in can't display the WordArt toolbar, you'll see these special effects 
options in the WordArt dialog box instead.

3 When you've finished working with WordArt, click where you want to work next.

What if...
I want to add a trademark or other symbol to the WordArt text?
In the Enter Your Text Here box, click in the text where you want to add the symbol, and then click

the Insert Symbol button to choose the symbol you want.
See Also
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 Adding Special Effects to Text in WordArt
After you've typed the text you want for WordArt, add special effects to the text with the WordArt toolbar.   
If the application you're working in can't display the WordArt toolbar, you'll see these special effects 
buttons in the WordArt dialog box instead.

To add a special effect to WordArt text
1 In the Enter Your Text Here box, type the text you want for WordArt.

Press ENTER each time you want to start a new line.
2 On the WordArt toolbar, click a button to choose a special text effect.

WordArt text can have more than one special effect, so you can click more than one button.    
Experiment until you find a look you like.    For a complete description of each effect, see the A 
Description of WordArt Special Text Effects topic referenced below.

3 When you've finished working with WordArt, click where you want to work next or choose OK in the 
WordArt dialog box.

What if...
I want to add a trademark or other symbol to the WordArt text?
In the Enter Your Text Here box, click in the text where you want to add the symbol, and then click

the Insert Symbol button to choose the symbol you want.
See Also

A Description of WordArt Special Text Effects
Typing and Editing Text in WordArt
Exiting WordArt



 Exiting WordArt
When WordArt looks the way you want, simply click where you want to work next.    You can edit WordArt 
at any time by double-clicking the WordArt.

To exit WordArt
Click where you want to work next.
Be sure to click outside the Enter Your Text Here dialog box, WordArt toolbar, and the WordArt 

itself.    
Note

If the application you're working in can't display the WordArt toolbar, you'll see the WordArt dialog 
box instead.    To exit the dialog box, choose OK when the text in the Enter Your Text Here box looks the 
way you want, or choose Cancel to exit the dialog box without making changes to WordArt.

See Also
Typing and Editing Text in WordArt
Adding Special Effects to Text in WordArt
A Description of WordArt Special Text Effects



 A Description of WordArt Special Text Effects
You can add many special effects to WordArt text.    For example, you can arch, flip, rotate, stretch, or add
a shadow to text.    In most applications, you'll add these options using the WordArt toolbar.    If the 
application you're working in can't display the WordArt toolbar, you'll see these special effects buttons in 
the WordArt dialog box instead.

You can add more than one effect, so experiment until you find a look you like.    

WordArt text options
To see a picture of the button, click the button name that appears underlined and in green below.

Shape
Click the arrow to choose a shape from the list.    For example, if you choose a semi-circle, the 
WordArt text will curve.

Font
Click the arrow to choose a font from the list.

Size
Click the arrow to choose a font size from the list.    When you select the Best Fit option, your 
application selects a font size that best fills the area you've drawn for your WordArt. 

Bold
Click the bold button to make the WordArt text thick.

Italic
Click the italic button to add a slight slant to the WordArt letters.

Even Height
Click the even height button to make all letters the same height regardless of capitalization.

Flip
Click the flip button to turn WordArt on its side.

Stretch
Click the stretch button to spread text both vertically and horizontally to fill the area you've drawn for 
your WordArt.

Align
Click the alignment button to position text in the area you've drawn for your WordArt.    If you don't 
select an alignment, WordArt is automatically centered.

Spacing Between Characters
Click the spacing between characters button to see options for adjusting the amount of room 
between each character.    Spacing Between Characters is often referred to as "kerning" or 
"tracking."

Rotation
Click the rotation button to see options for turning the WordArt text.

Shading
Click the shading button to see options for choosing a pattern or color for your WordArt text. 

Shadow
Click the shadow button to see options for choosing a shadow for your WordArt text.

Border
Click the border button to see options for choosing a border thickness for your WordArt text.



Tip
If you click a special effect and a dialog box is displayed, you can click the Help button if you want

more information on the choices in the dialog box.
What if

I'm done with WordArt, but I can't get rid of the WordArt toolbar or Enter Your Text Here dialog 
box?

Simply click where you want to work next.    Be sure that you don't accidentally click the Enter 
Your Text Here dialog box, WordArt toolbar or dialog box, or WordArt itself.    If you're working in the 
WordArt dialog box, choose OK.

See Also
Typing WordArt Text
Adding Special Effects to Text in WordArt
Exiting WordArt



  Editing WordArt
You can edit WordArt at anytime.    In most applications, you'll add these options using the WordArt 
toolbar.    However, if the application you're working in can't display the WordArt toolbar, you'll type your 
text and choose these special effects buttons in the WordArt dialog box instead.

 To edit WordArt using the WordArt dialog box
1 In the Enter Your Text Here box, edit or delete the existing text and then type the text you want for 

WordArt.
Press ENTER each time you want to start a new line.

3 Click the Update Preview button to update the text in the Preview box.
2 Click an arrow to choose a shape,    font, font size, alignment or color for the text.    Click a button to 

choose a special text effect.
You can add more than one effect at a time, so experiment until your text looks the way you want.    
The effects are described below.

4 When you WordArt looks the way you want, choose OK..

WordArt dialog box options

Enter Your Text Here area
Type the text you want for your WordArt.    Press ENTER each time you want to start a new line.

Insert Symbol button
Choose the Insert Symbol button to add a special character, such as a trademark. Click in your text 
where you want to add the character and then click the Insert Symbol button to choose the symbol 
you want.

Update Preview button
Choose the Update Preview button after you edit your text to update the text in the Preview box...

Apply
Choose the Apply button to see how the WordArt and WordArt text effects you've chosen look in 
your publication without closing the dialog box.        

Special Text Effect options

To see a picture of the button, click the button names that appear underlined and in green below.

Shape
Choose a shape from the list.    For example, if you choose a semi-circle, the WordArt text will curve.

Font
Click the arrow to choose a font from the list.

Size
Click the arrow to choose a font size from the list.    When you select the Best Fit option, your 
application selects a font size that best fills the area you drew for your WordArt.

Bold
Click the bold button to make the WordArt text thick.

Italic
Click the italic button to add a slight slant to the WordArt letters.

Even Height
Click the even height button to make all letters the same height regardless of capitalization.

Flip
Click the flip button to turn WordArt on its side. 



Stretch
Click the stretch button to spread text both vertically and horizontally to fill the area you drew for 
your WordArt.

Align
Click the alignment button to position text in the area you drew for your WordArt.    If you don't select 
an alignment, WordArt is automatically centered.

Spacing Between Characters
Click the spacing between characters button to see options for adjusting the amount of room 
between each character.    Spacing Between Characters is often referred to as "kerning."

Rotation
Click the rotation button to see options for turning your WordArt text.

Shading
Click the shading button to see options for choosing a pattern or color for your WordArt text.

Shadow
Click the shadow button to see options for adding a shadow to your WordArt text.

Border
Click the border button to see options for choosing a border thickness for your WordArt text.



 Spacing Between Characters Command (Format Menu)
The Spacing Between Characters command provides options for spreading characters out or moving 
them closer together.    When you adjust the amount of space between certain characters so that your text
looks more evenly spaced, it is called "kerning."      When you increase or decrease the space between all 
the characters in your text, it is called "tracking."    Keep in mind that kerning and tracking can make text 
easier to read or more difficult to read, so you may need to experiment a little.

Spacing Between Characters dialog box options

Tracking
Choose Normal to leave character spacing as it appears when you type.
Choose Very Tight or Tight to move characters closer together.
Choose Loose or Very Loose to spread characters apart.
Choose Custom and then click an arrow to fine-tune the amount of space between characters.

Automatically Kern Character Pairs check box
Choose the Automatically Kern Character Pairs check box if you want the spacing to be 
automatically adjusted whenever two characters appear next to each other.    An X in the check box 
indicates the option is chosen.

OK
Choose the OK button to add the option you've chosen and close the dialog box.

Cancel
Choose the Cancel button to close the dialog box without making any changes to the WordArt.



 Border Command (Format Menu)
The Border command provides options for choosing a border for your WordArt text.

Border dialog box options

Thickness
Choose None to remove a border from WordArt text.
Choose Hairline or Thin to add a narrow border around WordArt text.
Choose Normal to add an average border around text.
Choose Wide, Medium or Extra Wide to add a thick border around WordArt text.

Color
Click an arrow to choose a color for the border.    If you choose Auto, the color of your border will 
match the color currently chosen in the Shading dialog box.

OK
Choose the OK button to add the border you've chosen and close the dialog box.

Cancel
Choose the Cancel button to close the dialog box without making any changes to the WordArt.

Tip
If you're text is smaller than 14pt, it will look better without a border.



 Shading Command (Format Menu)
The Shading command provides options for adding color and patterns to WordArt text.    You can make 
the text a plain color or fill the inside of WordArt text with one of a variety of patterns.    If you choose a 
pattern, you can color both the pattern and the area behind the pattern.

Shading dialog box options

Style
Choose a pattern to fill the WordArt text.    If you choose the box in the upper-right corner, the text 

will be a solid color with no pattern.    If you choose the box in the upper-left corner, the text will be clear.
Color

In the Foreground box, choose a color for the text or for the pattern in the text.
To see all of the colors available to you, click the arrow to the right of the Foreground box and 

scroll down the list.
In the Background box, choose a color for the area behind the pattern in the text.
To see all of the colors available to you, click the arrow to the right of the Background box and 

scroll down the list.
Preview

Displays the pattern and colors you've chosen.

OK
Choose the OK button to add the pattern and colors you've chosen to the WordArt text and close the
dialog box.

Cancel
Choose the Cancel button to close the dialog box without adding a new pattern or color to the 
WordArt text.



 Shadow Command (Format Menu)
The Shadow command provides options for choosing a shadow and shadow color for your WordArt text. 

Shadow dialog box options

Choose A Shadow
Click a box to choose a shadow for the WordArt text.

Shadow Color
Click an arrow to choose a color for the shadow.

OK
Choose the OK button to add the shadow you've chosen and close the dialog box.

Cancel
Choose the Cancel button to close the dialog box without making any changes to the WordArt.



 Stretch To Frame Command (Format Menu)
The Stretch To Frame command expands your WordArt text horizontally and vertically to fill the entire 
WordArt frame.    To undo the stretched effect, choose the Stretch To Frame command again.



 Rotation and Effects Command (Format Menu)
The Rotation and Effects command provides options for adjusting the rotation of WordArt text.    
Experiment a little to find the look you want.    The options in the dialog box change depending on the type
of object you have selected.

Rotation and Effects dialog box options

Rotation
Click an arrow to rotate text.

Slider
Click an arrow to change the shape of text.    If you've already added a WordArt shape to the text, 
the slider adjusts the shape you've chosen.

Arc Angle
Click an arrow to adjust the curve of text.    This option is available only when you've already 
selected an arched shape for WordArt.

Reduce Letter Height By
Click an arrow to choose a larger or smaller height for letters.    This option is available only when 
you've selected a circle or arched shape for WordArt, and when the font size you've chosen is Best 
Fit.

OK
Choose the OK button to rotate or adjust the shape of the WordArt and close the dialog box.

Cancel
Choose the Cancel button close the dialog box without making any changes to the WordArt.



 Insert Symbol
The Insert Symbol dialog box provides options for inserting a symbol, such as a trademark.    Each font 
displays its own set of symbols.

Insert Symbol dialog box options
From the list of available symbols, choose the symbol you want to insert in your WordArt text.
WordArt inserts the symbol at the insertion point in the Enter Your Text Here dialog box.

OK
Choose the OK button to add the symbol you've chosen and close the dialog box.

Cancel
Choose the Cancel button to close the dialog box without making any changes to the WordArt.



 Search For Help On (Help Menu)
The Search For Help On command allows you to get help by typing a word or phrase related to the 
subject you want help with.    WordArt locates information on the word or phrase you've typed and 
suggests Help topics for you to read.

Search dialog box options

Type A Word, Or Select One From The List
Type a word or phrase on which you want more information or choose from the list of topics that 
WordArt provides.    Click the arrow to the right of the list to see more choices.

Show Topics
Choose the Show Topics button to see a list of all the Help topics available for the word or phrase 
listed in the Type A Word box, or Select One From The List box.

Select A Topic, Then Choose Go To
Select a Help topic from the list.

Go To
Choose the Go To button to see the Help topic you've chosen.

Close
Choose the Close button to return to the current page in your publication without displaying a Help 
topic.



 How To Use Help Command (Help Menu)
The How To Use Help command provides instructions for using Help.



 About Microsoft Publisher Command (Help Menu)
The About Microsoft WordArt command displays the product version number and copyright notice.



 Low Memory
Your computer uses a temporary storage area called Random Access Memory, or RAM, to run most 
applications.    Right now there isn't enough memory available to continue the task you've been working 
on.    Follow the instructions provided below to free up memory.    Remember that you'll need to exit this 
Help window before you can continue the procedure below.    To exit Help, from the File menu, choose 
Exit.

 To free up memory so that Publisher can continue
1 Choose the OK button to close the message box and return to your publication.
2 From the File menu, choose Save to protect the work you've done so far.
3 Click the Minimize button in the upper-right corner of the Publisher window to shrink Publisher to an 

icon while you close other applications.
4 Close any open applications.    For example, if you're running Microsoft Word for Windows, choose 

Exit from the Word File menu.
5 Double-click the Publisher icon to reopen the Publisher window.
6 Try completing the task again.

Note
In some cases, you may not be able to complete a task even after saving your work and closing 

other applications.    In this case, you may try exiting and restarting Windows and Publisher.



alignment button
Use this button to align WordArt text within the area you drew.



application
Software that helps you perform specific tasks.    For example, word-processing applications help you 
create and print text-based documents.    There are many applications that use WordArt.



bold button
Use this button to make each WordArt character thicker.



border button
Use this button to add a border around each WordArt character.



characters
Letters, numbers, spaces, punctuation marks, and various symbols that make up the text of a document.



check box
A box next to an option within a dialog box.    An X appears in the box when the option is selected.    Click
the box to add or remove the X.



choose
To use a mouse or key combination to specify an item in a Windows-based application.    For example, 
you choose a command from a menu by clicking the command.



clear
To remove the X from a check box by clicking on it.



click
Press and release the left mouse button.



dialog box
A window that displays options for you to choose or type.    These options give the application you're 
working in information needed to carry out a command or action.    A dialog box is your way of 
"conversing" with the application.



double-click
To press the left mouse button twice, in quick succession.



flip button
Use this button to turn WordArt characters on their side.



font
A family of letters, numbers, punctuation marks, and symbols with a similar shape or design.



font size 
The height of the characters in a font, usually measured in points.    There are 72 points per inch and 28 
points per centimeter.



font size box
Use this box to change the font size of WordArt characters.



font box
Use this box to change to a different family of letters, numbers, punctuation marks, and symbols with a 
similar shape or design.



icon
A graphical representation of one of an application's features.    WordArt uses many icons, for example, 
the icons on the buttons on the toolbar.    Windows uses icons to represent other applications.



italic button
Use this button to add or remove the italic text format from text. 



list box
Part of a dialog box that contains items for you to choose.    Some list boxes stay the same size; others 
drop down to display the list of items.



memory (random access memory, RAM)
The temporary information storage area your computer uses to run applications and perform other 
necessary tasks.    When you turn off the computer, all information in your computer's memory that you 
have not saved to a disk using the Save or Save As command is lost.



minimize
To shrink a window or application so that it becomes an icon.    You can minimize an application by 
clicking on the Minimize button at the upper-right corner of the window or by choosing Minimize from the 
Control menu.    To restore an application that you have minimized, double-click the icon.



rotation
WordArt text can turn 360 degrees.    For example, you can rotate text to display it upside down.



rotation button
Use this button to rotate WordArt text up to 360 degrees.    



scroll
Sometimes you need to move a window's contents horizontally or vertically to see all the information in a
window.    This is called scrolling.    To scroll, click one of the arrows in the scroll bars at the right and 
bottom of the window.



shading
Pattern that appears within each character.    For example, WordArt text can display colored dots, stripes,
or one of a variety of weaves.



shading button
Use this button to add a pattern or color to Word Art text.



shadow
Appearance of a shadow behind each character so that the text appears to float.    Shadows add a sense
of depth and perspective to text.    



shadow button
Use this button to add one of a variety of shadows to WordArt text.



shape 
Angle or curve in which WordArt text displays.    For example, if you choose a semi-circle shape, WordArt
text will appear curved.    



shape box
Use this box to choose the angle or curve in which text displays.    For example, if you choose a semi-
circle shape, Wordart text will appear curved.    



spacing between letters
Spreads letters out or moves them closer together.    Adjusting the spacing between letters is also called 
"kerning."



spacing between letters button
Use this button to spread WordArt characters out or move them closer together.    



stretch 
Text expands horizontally and vertically to fill the space designated for WordArt.



stretch button
Use this button to expand text horizontally and vertically to fill the area you've drawn for your WordArt.



even height button
Use this button to make all WordArt characters the same height regardless of capitalization.



WordArt
Special effects that you can use to enhance text.    WordArt has an Enter Your Text Here box to type the 
text and a toolbar to add special effects.    Some of the effects include arching, rotating, stretching, 
flipping, and adding shadows to text.



Word Art dialog box
The box that WordArt displays that contains the options for adding special effects to WordArt text.    You'll
see this box when you edit WordArt by choosing a command from the Edit menu, or when the 
application you're working in can't display the WordArt toolbar.



WordArt toolbar
A row of buttons for adding special effects to WordArt text.    The Wordart toolbar is located along the top 
edge of the workspace.
Note:    If the application you're working in can't display the WordArt toolbar, you'll see these special 
effects buttons in the WordArt dialog box instead.




